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1 Introduction

1.1 General Description

This manual describes the ATM (Automatic Tuning and Matching) Accessory for probe-
heads with selective, tunable, broad-band and switched channels. The ATM Accessory
consists of hardware, which is part of the probe or an option, and some commands in the
TopSpin software.

The ATM Accessory allows to optimize the tuning and matching automatically for each
sample.

1.2 ATM Features

• Automatic matching and tuning of all routed nuclei (nucleus must be observable)

• Optimal performance (S/N) in automation, e.g. when using a sample changer

• Easy manual matching and tuning via remote software control

• Automatic nucleus change on broad-band and switched probes

• Easy set up for new nuclei on broad-band and switched probes

• Elegant installation of probe heads equipped with ATM Accessory into the magnet
without the need for mechanical adjustments

1.3 Scope of this Manual

This manual describes the current state of hardware and software at the release date.

This is the included hardware and software:

Unit Version
Spectrometer AVANCE series 
ATM for RT probes all
ATM for Cryo Probes all
HPPR/1 all except CRP HPPR
HPPR/2 all
Internal HPPR all
ATMA Server 3.92
TOPSPIN 2.1 pl5, most ATMA features since 1.3

Table 1.1:  Hardware and Software Described in this Manual
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Introduction
1.4 The Two Different ATM Types

There are different ATM Accessories for RT probes or CryoProbes, but the control with
TOPSPIN is exactly the same

Difference RT probe ATM Accessory CRP ATM Accessory
Actuator The actuator unit is perma-

nently mounted on the probe-
head.

The actuator unit can be 
detached from the probe.

Upgrade Upgrading the probe head 
with the ATM Accessory is 
not possible.

The ATM Accessory can be 
added on newer cryo probes, 
even when the probe is cold.

PICS The ATM Accessory is con-
nected and controlled by the 
probe head PICS.

The ATM Accessory has its 
own, probe head independ-
ent, PICS.

Tuning and 
matching 
adjust

Only the actuator will trim the 
tuning and matching.

The user can adjust the 
nucleus manually by install-
ing the manual tuning and 
matching adapter.

Freezing The actuator unit cannot 
freeze.

The ATM Accessory has an 
integrated bottom heater to 
prevent from icing on the 
mechanical connection.

Table 1.2:  Differences Between RT and CRP ATM Accessory
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2 Safety

2.1 Warnings and Notes in this Manual

There are different types of information notices used in this manual. These notices high-
light important information or warn the user of a potentially dangerous situation. The fol-
lowing notices will have the same level of importance throughout this manual.

Indicates a hazardous situation which, if not avoided, may result in minor or moderate injury 
or major material damage.

Hazard, which could result in material damage.

i Information

Hints for convenient working and optimal performance of the system.

CAUTION
Type and source of danger
What might happen?

„ Counter measure 1

„ Counter measure 2

„ ...

NOTICE
Type and source of danger
What might happen?

„ Counter measure 1

„ Counter measure 2

„ ...
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Safety
2.2 Disclaimer

• The unit should only be used for its intended purpose as described in this manual. 

• Use of the unit for any purpose other than that for which it is intended is done so at
the users own risk and invalidates any and all manufacturers warranties.

• Service or maintenance work on the unit must be carried out by qualified personnel.

• Only those persons trained in the operation of the ATM Accessory should operate it.

• Read this manual before operating the unit. Pay particular attention to any safety
related information.

2.3 Site Considerations

The ATM Accessory should be setup in a standard laboratory environment. Maximum
room temperature should not exceed the range from 17-25°C. For more information
refer to the Avance spectrometer manual on site planning1 available from BRUKER
BIOSPIN.

NOTICE
Disclaimer
BRUKER BIOSPIN is not responsible or liable for any injury or damage that occurs
as a consequence of non-approved manipulations on the ATM Accessory.

„ Read the manual carefully before working with the ATM Accessory.

1.  See Appendix: A.5 References
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3 Installation

3.1 Installations Notes

CAUTION
Magnetic attraction
In the case of a strong magnet it is possible, that the probe may be
attracted. 
„ Be careful when moving the RT probe with ATM Accessory or CRP ATM Acces-

sory near the magnet.

„ Further information about probes can be found in Probes User Manual (BASH).

NOTICE
High torque damage probe
High torque on the mounting screws does not improve measurements but may dam-
age the probe or ATM Accessory.

„ Tighten the mounting screws alternately without using excessive torque and by
using the special handle.
11



Installation
3.2 Mounting RT probe

Inserting a RT probe with attached ATM Accessory is as easy as a probe without one.
The probe will be fixed to the shim system with two screws located inside the ATM
Accessory. The position of these screws is the same as for probes without ATMA. 

i The mounting screws in the actuator unit are hard to find if the probe is inserted into the
magnet. See the picture below and memorize the positions of the screws before mount-
ing the probe.

Figure 3.2: RT Probe with ATM Bottom View

Figure 3.1: RT Probe with ATM Mounting Screws

Mounting screws
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3.3 Mounting CRP ATM Accessory

1. Install the cryo probe into the magnet.
Plug in the VT-air tube and connect the CABLE BVT-CRP (P/N Z14278).

2. While mounting the ATM actuator unit make sure that the alignment bolts are posi-
tioned correctly with the probe.
Some force is required to push the ATM actuator unit to the bottom plate of the Cry-
oProbe (to compensate the force of the springs).
For this see the picture ”Cryo Probe ATM Mounting” on page 14

NOTICE
Cold CRP can warm up
When upgrading a cold probe with a ATM Accessory, the bottom heater must be
switched off.

„ Enter the service mode in CryoTool or CryoPanel and switch off the Temp. Ctl 3
(Bottom-H).

„ After this, you can detach the bottom heater cable from the mechanical tuning &
matching adapter.

„ When the ATM Accessory is mounted and bottom heater cable is connected, do
not forget to switch on the Temp. Ctl 3 (Bottom-H) in CryoTool or CryoPanel.

Figure 3.3: CryoTool Bottom Heater

Bottom heater
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3. Tighten the three screws at the bottom of the ATM actuator unit by hand.

4. Make sure not to have squeezed the VT-air hose: Check at the BVT-Unit that the air
flow is still present.

Figure 3.4: Cryo Probe ATM Mounting

Attention!
Do not squeeze the
VT-air hose.

VT-air hose

BVT-CRP cable

push
Mounting screws
14 Z4D10872b
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Installation
3.4 Connecting the ATM Accessory

To operate the ATM Accessory a connection from the probe to the HPPR is required.
Depending on the HPPR, different cables are needed

For the CRP ATM actuator unit an additional cable is needed to connect the cryo cooler.

HPPR PICS cable number PICS cable label
HPPR/1 Z2927 HPPR/PIC SYSTEM
HPPR/2 Z14361 HPPR/2<->ATMA/PICS
Internal HPPR Z100240 HPPR/2 - ATMA/PICS

Table 3.1:  PICS Cables

Cooler Bottom heater 
cable number

Bottom heater cable 
label

CU/1 to CU/3 Z14374 BOTTOM ADAPTER
CU/4 Z106881 BOTTOM ADAPTER

Table 3.2:  Bottom heater cables
15872b



Installation
3.4.1 HPPR connector

Different HPPR have different connectors for the PICS cable. See the different HPPR
with their ATMA / PICS sockets on the subsequent pages. 

NOTICE
HPPR reset
Connecting while the HPPR is running, the HPPR may reset (lamps will black out).

„ If this happens, the HPPR must be initialized by typing the command ii in TOP-
SPIN. 

„ For further details consult the TOPSPIN Software Manual.

NOTICE
Similar sockets
Do not connect the PICS cable to the wrong socket on HPPR/2 or console.

„ Read the labels on the HPPR/2 or console sockets carefully.

Figure 3.5: External HPPR/1

On HPPR/1:

Connect the PICS 
cable to the con-
necter "PROBE-
HEAD PICS".
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Installation
Figure 3.6: External HPPR/2

On HPPR/2:

Connect the 
PICS cable to 
the connecter 
"ATMA/PICS".

Figure 3.7: Internal HPPR

On internal HPPR:

Connect the PICS 
cable to the con-
necter "ATMA/
PICS".
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Installation
3.4.2 ATM / Probe Connector

Connect the PICS cable on the connector on the side of the RT probe.

The CRP ATM actuator unit needs two cables.

i In TOPSPIN type edhead before using ATM.

Figure 3.8: ATM PICS Connector on an RT probe

Connect the PICS cable to the 
"PICS" connector

Figure 3.9: Connector on a CRP ATM actuator unit

Connect the PICS cable to the 
"PICS" connector

Connect the bottom heater cable.
18 Z4D10872b
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4 Using ATMA

4.1 TOPSPIN commands atma and atmm

The two commands atma and atmm, integrated in TOPSPIN, are described below. Both
commands relay on the edsp setting of the current data set.

• The command atma (automatic tuning matching automatically) is the way to
get the optimal performance. It will automatically tune and match your probe, with-
out any intervention.

• The command atmm (automatic tuning matching manually) is mainly used for
verifying the current, or calibrating a new nuclei position on broad-band probes. It
allows the positions of the tuning and matching rods of the probe to be operated
directly via the workstation. A separate window will be opened showing various con-
trols.

4.1.1 Remarks for atma and atmm

• Both commands, atma and atmm, will separately start the wobble procedure.

• The wobble width (wbsw) and the number of wobble steps (wbst) will be automati-
cally defined dependent on the nucleus. After finishing of atma or atmm, the old
state of wbsw and wbst will be restored. For atmm, user defined values can be
used with the option manWbsw

• A special wobble procedure is started when either atma or atmm is active. It has a
non equispaced frequency range and uses mostly an extended wobble sweep
width. So the wobble curve may look unfamiliar.

• atma will stop spinning the sample to obtain optimal results. After atma has fin-
ished, the old state will be restored.

• Both commands will store positions for tuning and matching. The command atma is
doing this automatically while atmm will ask if the values should be stored. Depend-
ing on the probe head positions for nuclei and solvents will be stored.

4.1.2 atma process

The command atma will automatically tune and match your probe, without any interven-
tion

atma will do the following operations:

1. Check if one of the actuators is on the end stop and has to be moved away.

2. Initializing the actuators if needed (see “Actuator Initialisation” on page 6-5-30.).

3. Read the probe information from the PIC system and get information of the routed
channel in TOPSPIN (e.g. edsp)
19872b



Using ATMA
4. Turn off the sample rotation and set the optimal wobble width (wbsw) and the
number of wobble steps (wbst) for the given channel

5. Set the broad-band or switched channels, to the configured nucleus. 

6. Start a special wobble process to get the best resolution. The wobble curve may
look unfamiliar

7. Optimize the tuning and matching in several optimization cycles

8. Stop the wobble process 

9. Restart the process at step 4, if another channel must be optimized

10. Restore the old value for wbsw, wbst and the sample rotation

11. Terminate the atma command with a specific status (description in chapter: Com-
mand Status). If optimization was not successful, a window with a message will be
shown.

4.1.3 atmm process

The command atmm allows the positions of the tuning and matching rods of the probe
to be operated directly via the workstation.

atmm will do the following steps:

1. Check if one of the actuators is on the end stop and has to moved away.

2. Initializing the actuators if needed (see “Actuator Initialisation” on page 6-5-30.).

3. Read the probe information from the PIC system and get information of the routed
channel in TOPSPIN (e.g. edsp)

4. Set the optimal wobble width (wbsw) and the number of wobble steps (wbst) for the
chosen channel

5. Set the broad-band or switched channels, to the configured nucleus. 

6. Start a special wobble process to get the best resolution. The wobble curve may
look unfamiliar

7. Open a window showing the various controls to operate the matching and tuning
rods (see next chapter: atmm graphical user interface)

8. Stop the wobble process and confirm storing the tuning and matching information.

9. Restart the process at step 4, if another channel was selected

10. Restore the old value for wbsw and wbst

11. Terminate the atmm command with a specific status (description in chapter: Com-
mand Status)
20 Z4D10872b
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4.1.4 atmm control window

The command atmm will open the control below.

4.1.4.1 Menu structure

• File -> Save Position
Save the current actuator positions, see also ”Stored Tuning and Matching Values”
on page 31.

• File -> Quit
Close the window and terminate atmm. When changed, a dialogue asks if the new
position should be stored.

• Optimize -> Start
Starting the atma process 

• Optimize -> Stop
Stopping the atma process

• Help -> Probe-Info
Shows information about the probehead

• Help -> Version
Shows version of the ATMA server

• Help -> Options
Shows the available options for the ATMA commands atma and atmm

Figure 4.1: The atmm control window

Section for fine tuning 

Section for coarse tuning
(only on broad-band chan-
nels)

Section for coarse matching
(only on broad-band chan-
nels)

Section for fine matching

Current probe and solvent info

Selected nucleus
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Using ATMA
4.2 Options for atma and atmm

The table shows the available options for the commands atma and atmm. 

1) Works only when a probehead with ATM Accessory is connected.

Option atma atmm Description
low X X wobbles with all routed nuclei starting at the lowest 

frequency. This is also the default option
high X X wobbles with all routed nuclei starting at the highest 

frequency
f1 - f8 X X wobbles the specified channels in the given order; 

example, f1 f3 f2 f1
xchannel X X wobbles all routed X channels, example 

on TXI 13C & 15N
proton X X wobbles the proton-channel
selectNuc X X on broad-band probes, sets the broad-band channel 

to the configured nucleus and terminates the atma 
command. No optimization will be done

ext50 X X takes the reference with a external 50Ohm terminator, 
instead using the internal 50Ohm reference. If the 
wobble process takes a long time to optimize, the ref-
erence may drift away

version X X 1) shows the actual ATMA software version. No optimi-
zation will be done

probeInfo
(= bbInfo, drivePos)

X X shows information of the connected probe head, 
about broad-band and switched nuclei and the posi-
tion of the drives. No optimization will be done

? (= options) X X shows all available options for atmm and atma. No 
optimization will be done

manWbsw X use the actual wobble width (wbsw) and the number 
of wobble steps (wbst) for the wobble process

acqu X X read SOLVENT information from current data set 
(eda, curdat/. ./acqu) and not from global locksolv file

changePositionSet ’#’ X X change the number of position set used for this 
nucleus by setting ’#’ [0, 1(default) ... 10] 

stop X stop a running atma optimization ('atmopt' in the sta-
tus line)

exact X gets the best optimization but can take a long time to 
complete

coarse X is faster to complete but will perform a less accurate 
optimization

noWin X shows no message window if atma couldn’t find the 
optimum. Useful for scripts

storeWobb 'PROCNO' X store wobble data, data is stored with passed 
PROCNO

Table 4.1:  atmm and atma options
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4.2.1 Examples for atma and atmm

• atma or atma low
will automatically tune and match all observable routed channel starting at the low-
est frequency

• atma f2 coarse
atma f1 exact
optimize tuning and matching for f1 (e.g.1H) very accurate and for f2 (e.g. 13C) fast

• atma proton
optimize tuning and matching only for 1H

• atma xChannel
optimize tuning and matching for all routed channels (13C, 15N), except for 1H

• atma selectNuc
sets the broad-band channel to the requested and terminates the atma command.
No optimization will be done

• atma f1 f3 f1 noWin
will automatically tune and match the channel f1, f3 and again f1. If it get an error no
message window will be shown

• atmm f1 manWbsw
starts the wobble process on channel f1 using the actual wobble width (wbsw) and
the number of wobble steps (wbst)

• atma version
shows the version of the installed ATM software and the release notes

Figure 4.2: The atma version window
23872b



Using ATMA
• atma probeInfo
shows the message window below

• atma changePositionSet 5
is setting up atma to work with 5 different settings where the optimum for the tuning
and matching is expected.

• atma f1 acqu
is tuning and matching f1 with the solvent information read from the current dataset.

• atma f1 storeWobb 10
is optimize tuning and matching for f1 and stores the result to ’PROCNO’ 10.

Figure 4.3: The probe info list
24 Z4D10872b
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4.3 Verify a new nucleus on the broad-band channel

To set up the broad-band channel for a new nucleus the following steps must be done:

1. Check with the command atmm probeInfo if the nucleus can be used with the
probe. The range of the broad-band channel is shown e.g. “31P-109Ag”.

2. Connect the broad-band channel to a HPPR module which can wobble the
requested nucleus, e.g. 2H or 19F can’t be wobbled on some modules.

3. Configure the nucleus with the edasp command (start with a low frequency nucleus,
because they are easier to set up).

4. Start the command atmm to verify the new nucleus. This must be done once for
every new nucleus (Note: this is also true for the factory predefined nuclei which are
shown in brackets in the bbInfo window)
The wobble width (wbsw) will be set very large. So the dip should be visible.

5. First use the tune coarse buttons (+ and -) to set the dip in the middle of the window,
then use the match coarse button to get a good matching
If no dip is visible set the wobble width manually. Exit the atmm command (don’t
save the position) and set the wobble width with wbsw. Now restart the atmm com-
mand with atmm manWbsw.

6. Use the fine buttons (<, <<, <<<, >, >>, >>>) to get an optimized dip.
If the button colour is red, the dip can’t move further in this direction. Set up the
coarse position again (last step).

7. To check the position of the coarse buttons do one step up and down. The best
position should now be between the two.

8. Close the atmm window and save the new position.

9. atmm probeInfo should now show the new nucleus.
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4.4 Specialities

4.4.1 1H and 19F with QNP switch

If your probehead can observe 19F and decouple 1H (eg: QNP F-P-C-H), and you have
only one 1H amplifier with a QNP switch (using the zgfhig pulse program to switch), then
the ATMA fails to tune the 1H. It tries to tune both the 19F and the 1H using the X-BB
preamp because the path for 1H to the 1H preamp is not in edasp.

i Run atma for each channel seperately with two different datasets using only one
nucleus for each dataset. Start with the 19F channel first and do the 1H afterwards.

Figure 4.4: Atma fails to tune 1H

Figure 4.5: Routing 19F to 1H
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4.4.2 Two 19F Channels

On some probe heads you can set the broadband and the proton channel to 19F. Those
probeheads are labelled for example "BBF-H&F-D". In this case you have to take care to
not mix up the two channels.

TopSpin sets the routing for the 19F regarding the sensitivity.

To force TopSpin not to use the default, you have to occupy the second possibility for
19F by routing an unused channel. Then run the atma command with the f1 or f2 option.

4.4.3 Internal HPPR and no Position Detection

Since the internal HPPR 1H/2H module has a built-in 19F filter, the visible area of the
wobble curve is very narrow. After a sample change on a inverse probe, the shift from
the sample can be too high. ATMA may not see the dip any more and tries to find the dip
blind. This may work but very often it does not.

This is way ATMA stores the positions according to the solvent. So it has good starting
positions after a solvent change. In this case a position detection is required (see “Actu-
ator Initialisation” on page 6-5-30.).

Probehead Type Default channel for 19F
Observe Broad band (BB)
Inverse Proton and fluorine (H&F)

Table 4.2:  Default channel for 19F

Figure 4.6: Routing 19F to 1H
27872b



Using ATMA
28 Z4D10872b



Z4D10
5 ATMA Knowledge

5.1 ATMA Software Architecture

The ATMA software was built as server and client. When using an atma or atmm com-
mand for the first time in TOPSPIN, the server will be started. From then the ATMA
server is running, all the ATMA commands will run as a temporary active client.

The environment variables for the ATMA server will be set only once when the server is
started. When having problem with the ATMA, close the whole TOPSPIN application, in
order to stop the ATMA server.

5.2 Installing ATMA Patch

TOPSPIN and its patch levels comes with an ATMA server. But you can manually down-
load and install an newer version of the ATMA server. This may be required if a new fea-
ture was included in a ATM server version but a new TOPSPIN patch level has not been
released.

i The ATMA server is part of the TOPSPIN software and its patch levels.

i Make sure to use ftp binary mode when downloading files from ftp server. If you are
using ftp ASCII mode the archive files will be corrupt.

To install a new ATM Patch do the following steps

1. Verify with the command atmm version if the installed ATM Version is older then
the latest available version

2. Get the latest version from the Bruker ftp-server. 
ftp://ftp.bruker.ch/pub/NMR/download/atm/

3. Copy the file or files to the correct folder. Do not forget to backup the old file version.
See “ATMA Files and Folders” on page 6-5-35. for the correct folder.

4. Restart the TOPSPIN software.

5. Verify with the command atmm version if the installed version is running.
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5.3 Actuator Initialisation

Some ATM Accessory will start with an initialisation procedure what is used to work with
position detection. This depends on probe head age and type. To find out for what posi-
tion detection is used, read ”Stored Tuning and Matching Values” on page 31.

i Depending on the probe head the initialisation can take a some minutes.

The following table indicates, in which case the initialisation is proceeded.

Probe head Position detection Initialisation
QNP and QNI (RT probe and CRR), MNP (CRP) Yes Yes
RT broad band probe heads Yes Yes
RT inverse probe heads produced after 2007 Yes Yes (from 3.921)

1H (before 3.92)
Other RT probe heads produced after 2007 Yes Yes (from 3.92)

No (before 3.92)
Other RT probe heads produced before 2007 No No
Other cryo probes No No

Table 5.1:  Actuator Initialisation

Initialisation trigger RT probes Cryo probes
Command atma or atmm after HPPR power failure x x
Command atma or atmm after PICS cable connected x x
Command atma or atmm after actuator unit attached to 
probe head

x

Table 5.2:  Initialisation Trigger
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5.4 Stored Tuning and Matching Values

ATMA is storing values into a file in order to provide a start value for finding the dip on
subsequent NMR tubes. Read the following pages about what is stored and when the
values are stored.

The files, in which the information is stored, has the extension ".bb". To locate the file in
the file system see See “ATMA Files and Folders” on page 6-5-35..

The following file is an example file with the ".bb" extension. This file contains all the dif-
ferent specialities. The important part of the line is printed bold.

i The "@" character is used to mark different position sets in the ".bb" file. Do not confuse
ATMA by using solvent names containing this character.

Figure 5.1: Example ATMA ".bb" File

ATMA Feature Probe Type Example File Description
Broad band channel 
nucleus position

Broad band (BBO, BBI) Line 1 to 10 chapter 5.4.1 on 
page 32

Switching channel 
nucleus position

Switching (QNP, QNI, MNP) Line 11 to 13 chapter 5.4.2 on 
page 32

Tunable channel 
nucleus position

Probe labelled: "1H&19F/..." Line 14 and 15 chapter 5.4.3 on 
page 32

Solvent depending 
tuning and Matching

All selective channels (Probe-
heads with position detection)

Line 16 to 20 chapter 5.4.4 on 
page 32

Solvent Variations All selective channels (Probe-
heads with position detection)

Line 21 to 23 chapter 5.4.4.1 
on page 33

Initialisation Version All Line 24 - 

Table 5.3:  ATMA Features

$probebbsets,1.0,31P,+799.0174,+99.0320,+110.00,+005.00,+000.40,+000.10#
$probebbsets,1.0,87Rb,+798.0182,+99.0275,+110.00,+005.00,+000.40,+000.10#
$probebbsets,1.0,13C,+795.0108,+99.0124,+180.00,+005.00,+000.40,+000.10#
$probebbsets,1.0,2H,+785.0365,+87.0226,+180.00,+005.00,+000.40,+000.10#
$probebbsets,1.0,17O,+777.0260,+92.0096,+180.00,+005.00,+000.40,+000.10#
$probebbsets,1.0,15N,+758.0104,+78.0231,+210.00,+005.00,+000.40,+000.10#
$probebbsets,1.0,14N,+709.0261,+65.0140,+210.00,+005.00,+000.40,+000.10#
$probebbsets,1.0,97Mo,+687.0195,+59.0213,+210.00,+005.00,+000.40,+000.10#
$probebbsets,1.0,109Ag,+536.0135,+14.0155,+210.00,+005.00,+000.40,+000.10#
$probebbsets,1.0,19F,+002.0137,+00.0165,+093.10,+000.00,+000.00,+000.00#
$probebbsets,1.0,31P,+001.0092,+00.0170,+040.10,+000.00,+000.00,+000.00#
$probebbsets,1.0,13C,+000.0187,+00.0198,+096.10,+000.00,+000.00,+000.00#
$atmaposset,1.0,1H,1H,1M NaCL H2O+D2O,-001,+000.0008,+00.0006,+040#
$atmaposset,1.0,1H,19F,1M NaCL H2O+D2O,-001,+000.0008,+00.0006,+040#
$atmaposset,1.0,1H,1H,CDCl3,-001,+000.0019,+00.0034,+040#
$atmaposset,1.0,1H,1H,C6D6,-001,+000.0022,+00.0037,+040#
$atmaposset,1.0,1H,1H,Acetone,-001,+000.0015,+00.0039,+040#
$atmaposset,1.0,1H,1H,DMSO,-001,+000.0012,+00.0037,+040#
$atmaposset,1.0,1H,1H,D2O_S1000,-001,+000.0046,+00.0015,+040#
$atmaposset,1.0,1H,1H,H2O+D2O,-001,+000.0011,+00.0040,+040#
$atmaposset,1.0,1H,1H,H2O+D2O@1,-001,+000.0011,+00.0040,+040#
$atmaposset,1.0,1H,1H,H2O+D2O@2,-001,+000.0011,+00.0040,+040#
$atmainfo,1.0,+001#

line 01
line 02
line 03
line 04
line 06
line 07
line 08
line 09
line 10
line 11
line 12
line 13
line 14
line 15
line 16
line 17
line 18
line 19
line 20
line 21
line 22
line 23
line 24
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5.4.1 Broad Band Channel Nucleus Positions

On a broad band channel the tuning and matching information for all nuclei is stored. For
some of the nuclei there has already been stored a preset value in the PICS. For these
nucleus you can start the atma command without any preparation work. For other nuclei
in the frequency range (e.g. from 13C to 109Ag) you have to run the atmm command
first to set and store the tuning and matching values. The wbsw parameter is calculated
for new nuclei.

You can see such tuning and matching positions in example file Figure 5.1 on page 31
from line 1 to 10.

5.4.2 Switching Channel Nucleus Positions

On switched channels the tuning and matching information for the nuclei are stored in
the ".bb" file. All the available nuclei and their wbsw parameters are defined in the PICS
and cannot be changed.

You can see such tuning and matching positions in example file Figure 5.1 on page 31
from line 11 to 13.

5.4.3 Tunable Channel Nucleus Positions

Some probe heads are equipped with a proton channel that can be tuned to fluorine as
well. These probe heads are labelled for example: "1H&19F/...." and treated like a
switching channel. The tuning and matching information is stored independent for 1H
and 19F.

You can see such tuning and matching positions in example file Figure 5.1 on page 31
line 14 and 15.

5.4.4 Solvent Depending Nucleus Position

All selective channels with position detection (See “Actuator Initialisation” on page 6-5-
30.) will automatically store tuning and matching information together with the current
solvent you have locked on. This is especially helpful if your channel is sensitive to the
employed NMR solvent.

You can see such tuning and matching positions in example file Figure 5.1 on page 31
from line 16 to 20.

i Changing the solvent with the solvent command does not set the solvent used for atma
in any case. Use the atmm command to see the solvent in the footer in the window and
the atmm acqu command to use the solvent of the current data set.
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5.4.4.1 Solvent Variations / Position Set

When using salty solvent with different salt concentrations, it might be necessary to try
different tuning and matching settings. You can manually set the ATMA to up to 10 differ-
ent position sets for starting tuning and matching on selective channels.

With the changePositionSet [0...10] option after the atma command you can set the
required numbers of sets.

Setting the number of position sets:

1. First set the tuning and matching manually with the atmm command.

2. Then copy this value into the new sets with atma changePositionSet and the
required number.

3. Confirm the setting on the dialogue shown in Figure 5.2.

Deleting position sets:

1. Delete all the positions sets or just the additional ones by setting the positions set
variable to 0 or 1.

2. Confirm the setting on the window shown in Figure 5.2.

Such stored tuning and matching positions are given in the example file Figure 5.1 on
page 31 from line 20 to 23. In this example three position sets where used where line 20
corresponds to one position set and line 23 to 3 position sets.

Figure 5.2: Changing Position Set
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5.5 Command Status

The atma and atmm commands return a status after termination. When writing user
specific TOPSPIN macros, these status can be required. The status can take the follow-
ing values:

Return value Meaning
0 Command executed successfully
-1 Command not successful; resonance dip not found
-4 Aborted because a Stop Command was received
3 Communication failed (PICS)
6 System procedure error (wobble not possible)

Table 5.4:  Status return values
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5.6 ATMA Files and Folders

The following list shows files in a TOPSPIN installation used by ATMA.

These files are part of the installation and must not be deleted
/opt/topspin/... Description
conf/instr/servtool/hpprtool/tool/atma.hlp
conf/instr/servtool/hpprtool/tool/atmamot.hlp

Atma help for HPPRtool

conf/instr/servtool/unitool/... Atma help in UniTool
guide/man/acqref/atma.html
guide/man/atma
guide/man/atma/contents.htm
guide/man/iconnmr/images/atma.PNG

ATMA description used by TOPSPIN 
help.

prog/docu/english/xwinproc/html/atma.html
prog/docu/english/xwinproc/pdf/Atma.pdf

ATMA description 

prog/mod/atmaclient
prog/mod/atmaserver

ATMA server and client

conf/instr/[curinst]/probeheads/curprobe Current probe head / ATMA in use

Table 5.5:  ATMA Files and Folders from the Installation

These files are generated by ATMA and can be deleted
/opt/topspin/... Description
prog/curdir/[user]/ATMALOG Control file for ATMA logging. Available 

from ATMA version 3.91. See “Starting 
ATMA Logfile” on page 6-5-39.

prog/curdir/[user]/AtmaServer.ref CORBA reference to ATMA server.
prog/curdir/[user]/stderr.AtmaClient.log
prog/curdir/[user]/stderr.AtmaServer.log
prog/curdir/[user]/stdout.AtmaClient.log
prog/curdir/[user]/stdout.AtmaServer.log

ATMA default logfiles.

conf/instr/[curinst]/probeheads/xxxx_xx.ph Cashed PICS files for fast access.
Auto generated and updated by ATMA

conf/instr/[curinst]/probeheads/xxxx_xx.pha Cashed PICS files from CRP ATM actua-
tor unit for fast access. 
Auto generated and updated by ATMA

conf/instr/[curinst]/probeheads/xxxx_xxxx_xx.par PICS information used by edhead in 
jcamp format. Auto generated file by 
edhead.

conf/instr/[curinst]/probeheads/xxxx_xx.bb Stored ATMA values.

Table 5.6:  ATMA Files and Folders used for ATMA Software
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5.7 Troubleshooting

5.7.1 atmm or atma Errors

If atmm or atma generate an error, check the following points:

• Is the cable on the probe and HPPR plugged in?

• Is the HF cable attached to the correct channel of the probe?

• Is the corresponding nucleus observable (HPPR module)?

• Can the selected channel be wobbled with the standard wobb command?

• Try to move the matching and tuning with the atmm command.

• If the dip couldn’t be optimized with atma, try a second time.

• If the requested nucleus couldn’t be set on broad band probes, remove the PICS
System connector on the probe and then re-connect it.

• Restart the ATMA server by restarting TOPSPIN.

• Are the filters according to the filter manual?

• Does the RT probe has a position detection? (See “Internal HPPR and no Position
Detection” on page 5-4-27.)
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5.7.2 Checking Communication with ATMA

If you can download the PICS file from the probe head or ATM actuator unit, the commu-
nication is working. Depending on the HPPR different tools are used.

5.7.2.1 Communicating with HPPRtool

1. Type "hppr" in a shell on a Linux system or on the command prompt on a Windows
system.

2. After the start screen appeared, press "y" to continue

3. In the main menu Press "8" to select "Board function HPPR-Controller..."

4. Press "7" for the "PICS Function..."

5. Press "1" "Read Probehead PICS-Information"

6. This action will take some time. Wait until the PICS is shown in the window.
If the PICS appears the communication between HPPR and ATMA is working.

7. Press "return" and "q", "q", "q", "y" to quite the program.

5.7.2.2 Communicating with UniTool

1. Type "UniTool" in a shell with a Linux system or on the command prompt on a Win-
dows system.

2. Enter the device name "hppr"

3. Confirm the address 80 by pressing "return"

4. After the start screen appeared, press a button to continue

5. In the main menu Press "i" to select "CRP/ATMA/PICS ..."

6. For a RT probe press "P" to select "Show PICS"
For a CRP press "B" to select "Show CRP-ATMA BIS"

7. Wait until the PICS is shown in the window.
If the PICS appears the communication between HPPR and ATMA is working.

8. Press "return" and "q", "x", "return" to quite the program.

HPPR type HPPRtool UniTool Web interface
HPPR/1 x
HPPR/2 x
Internal HPPR x x
Read details in... chapter 5.7.2.1 on 

page 37
chapter 5.7.2.2 on 
page 37

chapter 5.7.2.3 on 
page 38

Table 5.7:  Communication with ATMA
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5.7.2.3 Communicating through web interface

1. Type "ha" in the TOPSPIN command line.

2. Open the DRU web interface

3. Select "AQS Hosted Devices" and then "HPPR/2 Overview"

4. For a RT probe press "read PICS" in the "CRP/ATMA/PICS" section
For a CRP press "read ATMA BIS" in the "CRP/ATMA/PICS" section

5. Wait until the PICS is shown in the window.
If the PICS appears the communication between HPPR and ATMA is working.

6. Close the browser window.

Figure 5.3: The DRU web interface

Open the DRU web interface

Figure 5.4: Reading PICS from DRU web interface
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5.7.3 Starting ATMA Logfile

If a ATMA causes problems that can not be solved with the checklist under ”atmm or
atma Errors” on page 36 you should produce an atma logfile and send it, together with
the uxnmr.info file and a problem description, to BRUKER for support.

There are two different ways to start the logging. Both ways give you the possibility of
selection a path for the logfiles and a logging resolution level (0= nothing to 100=every-
thing).

5.7.3.1 Start logging with debugmod

• Restart TOPSPIN and do not use any ATMA commands.

• Type the command debugmod in TOPSPIN.

• Select a path for the ATM logfile.

• Set the debug level to 100.

Logging modes Persistency Read details in ...
Command: debugmod Will be stopped together with TOPSPIN. chapter 5.7.3.1 on page 39
File: ATMALOG Will last as long as the file exists. chapter 5.7.3.2 on page 40

Table 5.8:  Different logging Modes

Figure 5.5: The debugmod window
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5.7.3.2 Start logging with the ATMALOG

If the commands atma or atmm will find the text file ATMALOG in the file system on the
path /opt/topspin/prog/curdir/[user]/ATMALOG the logging is enabled immediately.

File Content Logfile path Level
Empty text file same as ATMALOG 100
Text file with: "[path] [level]" from File from File

Table 5.9:  Different logging Modes

Figure 5.6: Example ATMALOG File

/home/nmr/myatmalogfiles/ 80line 01
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6 Contact

Submit your inquiries regarding ATMA to your local BRUKER BIOSPIN representative.
Use the following address to acquire further information.

6.1 Manufacturer

Bruker BioSpin AG

Industriestrasse 26

CH-8117 Fällanden

Switzerland

Phone:+41-44-825-91-11

Fax: +41-44-825-96-96

http://www.bruker.com

Please refer to the Model No., Serial No. and Internal Order No. in all correspondence
regarding the MR system or components thereof.
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A.4 Glossary

ATM Accessory
Automatic Tuning and Matching

BASH
Bruker Advanced Service Handbook

Broad-band channel
A range of nuclei on a probehead channel.

CRP
CRyo Probe

HPPR
High Power PReamplifier

Inverse
Probe with 1H on the inner, most sensitive coil

Observe
Probe with 1H on the outher, less sensitive coil

PICS
Probe Identification and Control System

RT
Room Temperature

S/N
Signal to Noise

Selective channel
IX872b



Appendix
One fixed nucleus on a probehead channel.

Switched channel
Several fixed nuclei on a probehead channel.

TOPSPIN
Bruker software for acquisition, processing and analysis

Tunable channel
A probe channel with an extended tuning range.
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A.6 Revision History

Index Date Who Alteration Type
001 18.6.1999 SSV First release
002 21.2.2000 SSV Broad band probe heads added

003 2.4.2009 SRE
From XwinNMR to Topspin
HPPR/2 added
CRP ATM added

Table A.1:  The Revisions of this Manual
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your solution partner

Bruker BioSpin Group

info@bruker-biospin.com
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Bruker BioSpin provides a world class, market-leader
range of analytical solutions for your living requirements
and  materials science needs.

Our solution-based approach enables us to work closely
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